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Introduction 
This manual provides standard operating procedures , recommendations step by step mission planning  

and image processing for drone based phenotyping.  This protocol is specifically designed for high 

throughput phenotyping of small breeder sized plots (1-6 m2) but will also work well for more general 

applications in crop monitoring.  The reader/pilot should already be trained in basic drone operation and 

safety and familiarized with the drone flight control software prior to conducting a drone mapping 

mission.  The mission is the general flight plan and includes all the information needed for flying the 

drone autonomously over the area of interest.  Once created and saved, it can be used repeatedly to fly 

the same mission or copied and saved to create new missions with the same set of parameters.  While 

mapping missions are flown autonomously, the pilot must always pay careful attention to the drone and 

be prepared to take control of the drone to fly it back and land manually at any time.   

Drone Operations 

Flight Control Software 
Numerous flight control applications (apps) exist for DJI multirotors including Pilot 2, DJI Go, DJI GS Pro, 

Map Pilot, Litchi, PIX4D Capture, Drone Deploy and others, all found on Apple’s or Googles App Store. 

The DJI GO app is primarily usefull for configuring DJI drone/camera general settings and flying 

manually, but not for conducting mapping flights.   The fixed wing Sensefly eBee comes with it’s own PC 

based flight control software, currently Emotion 3, which is well documented in the Sensefly knowledge 

base: https://my.sensefly.com/my-products.html.  Always remember to check for updates and fly using 

the most recent version. 

DJI’s software (iOS freeware) is easy to use and includes all the controls needed for mapping with DJI 

drones.  It  also provides helpful information such as estimated flight time, batteries needed, and 

number of pictures.  A WIFI connection is required when first setting up a mission in order to download 

the basemap satelite image for the field area.  The basemap area will be saved with every new mission 

so a WIFI connection is not needed during flight.  Step by step instructions for configuring a mapping 

mission using DGI GS Pro are provided in Appendix A. 

Best Time for Capture 
It’s useful to conduct a preliminary flight of the fallow field following land preparation but prior to 

flooding and planting in order to get baseline data for the field and to ensure the mission plan provides 

the proper coverage.  Fly weekly followng transplanting, or seedling stage in direct seeded applications, 

in order to capture changes in crop growth and performance over time. 

It’s generally recommended to fly within a few hours of local solar noon to avoid shadows within the 

plots.  This is however problematic for rice since the sun can produce bright sunspots in the images.  In 

this case, it’s better to fly earlier or later while the sun is at a lower angle. 

https://my.sensefly.com/my-products.html
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Try to avoid partially cloudy conditions, especially when clouds result in shadows over a portion of the 

field.  Ideal days are when the sky is clear or has uniform cloud cover.  In any event, record the sky and 

wind conditons for the field in your flight log. 

  
Examples of a sun spot in image, partial shading by clouds, and shaded but uniform lighting 

Aerial Coverage 
The area to be captured should be larger than the actual field of interest so that there is sufficient data 

all the way to the edges of the field.  Set up a 3DMap survey using your system’s mission planning utility. 

One additional flight track should be configured on either side of the field.  Also be sure there is 

sufficient space at the end of each flight track for the aircraft to re-align for the next pass. This is 

particularly important for fixed-wing drones. 

Flight Path Direction 
In general, the flight paths should be paralell to either the length or width of the field.  It is most 

efficient to align the flight paths paralell to the longest dimension of the field since this minimizes the 

number of turns the drone needs to make.  When setting up a flight mission over fields that have rows 

planted in a specific direction, the flight tracks should be oriented such that they are perpendicular to 

the rows when possible.  Also consider the wind direction when flying during windy conditions.  The 

drone will fly more efficiently and provide more even coverage when flying perpendicular to the 

direction of the wind.  So depending on the row and wind direction, either fly parallel to the length of 

the field or rotate the flight plan 90 degrees and fly paralell to the width of the field. 

Image Overlap 
When setting up the mission, pay careful attention to the altitude,  distance between tracks ( sidelap), 

and the distance between successive captures (frontlap).  These settings should be configured in the 

flight control software based on the drone and camera used (see table).  When using a dual camera 

drone (RGB & Multispec), the overlap parameters need to be set such that both cameras can achieve 

the minimum overlap.   

 

  Sun spot-avoid by 

flying earlier or later 

Partial shading- avoid by 

flying earlier or later or 

another day  

Uniform lighting-good 
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Drone Flight Settings 

Drone RGB Multispec Thermal 

eBee res cm/pix 2.0 6.0 10.0 

eBee altitude m 85 64 53 

eBee overlap 80side/75front 80s/80f 80s/90f 

eBee speed m/s 11  11 11 

Matrice res cm/pix 1.3 2.05  

Matrice altitude m 30 30  

Matrice overlap1 90s/80f 80s/80f  

Matrice speed m/s 3.9 3.9  

FP4 pro res 1.0   

FP4 pro altitude m 35   

FP4 pro overlap 80s/85f   

FP4 pro speed m/s 2.7   
1 Matrice dual cameras:  88% lateral overlap on RGB corresponds with 80% lateral on RedEdge 

FP4 pro: DJI Phantom 4 pro drone with 20MP RGB camera 

Camera Settings 
The basic camera settings that can be configured for an RGB camera are the format, image size, shutter 

speed, ISO, and white balance.  These settings can all be adjusted after connecting to the drone as 

described in Appendix A.  The standard format is JPG in which the images can be captured at the fastest 

rate possible (2 s, for DJI drones), and the images are compressed for efficient data handling and 

storage.  Note it is essential that the memory card has a fast write speed (up to 60MB/s) or it will not be 

able to keep up with the camera and images will be missed.  A good card is the 64GB SANDISK EXTREME 

microSD UHS-I CARD. Higher capacity cards (128GB) can be used in some drones like the Phantom 4 pro 

but 32-64GB is sufficient.  

The image size should be set to correspond with the highest resolution for the camera.  The ISO should 

always be set to 100 to provide the best quality images, higher values will result in reduced image 

Wind direction 
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quality.  White balance should be set based on the prevailing conditions, sunny or cloudy, not to 

automatic so that it remains consistent for the duration of the flight.   Focus and shutter speed can be 

left in automatic mode and the camera will then automatically adjust based on the lighting conditions.  

These settings generally only need to be adjusted once and will be retained in memory the next time 

you fly. 

Most settings for the fixed wing Ebee and multispectral cameras are automatic and don’t need manual 

adjustment.   One exception is when using the Sequoia multispec, the camera needs to be configured to 

the maximum resolution (1.2 Mpix) and no RGB, in the mission block tab of the Emotion flight control 

software. The Sequoia RGB is for scouting purposes and not of sufficient quality for mapping. 

Suggested RGB Camera Settings 

Camera Format Image size ISO Shutter  White Balance 

DJI X3, X5 jpg/raw 4:3 100 Auto Sun or cloud based on condition 

DJI FP4pro jpg/raw 3:2 100 Auto Sun or cloud based on condition 

eBee soda raw 3:2 auto Auto Auto 

Ground Control Points  
Use 6-8 ground control points (GCPs) per ha, placed around the perimeter of the 

field.  GCPs should be at least 0.4 x 0.4 m with black and white pattern to clearly 

indicate the center.  Larger GCP’s are necessary when imaging at lower 

resolutions, such as when using thermal cameras.  Use non-shiny paint and 

materials to avoid reflections.  GCPs can be made from foam-board, plastic, 

wood, metal or cement, and should be heavy enough or properly secured so 

they are not easily moved.    It’s critical that they are always positioned accurately so that the measured 

location of the center remains unchanged during each flight.  Use stakes or spray paint to mark the 

locations for easy replacement during successive flights or use permanently installed GCPs.  GCP 

locations need to be surveyed with a high accuracy (2-5 cm) GPS using the local UTM coordinate system.  

Always re-survey a GCPs location anytime you are unable to accurately position it in the measured 

location, and make note of this in the flight log for that day.  Also note if you observe a GCP was moved 

accidentally during a flight (i.e., by a person, vehicle, animal, or strong wind) if using removable GCPs.  

Flight Log 
It is important to maintain a flight log for recording each flight.  This should include: Date, location, 

number of flights conducted to complete the mission (in the case of a multibattery mission), camera 

type (RGB, multispec, or thermal), cloud cover (clear, overcast, or partly cloudy), wind condition (low, 

med, high, or m/s ), and additional observations such as problems with the flight (drone, camera, GCPs) 

or noteable field conditions (lodging, pest/disease,  people in field).  Add a column for drone type if your 

using more than one drone in your operation.  

Example flight log 

Date Location Flights Drone Camera Sky Wind Notes 

2018-08-03 B400 1 eBee RGB clr med  

2018-08-06 B600 2 M100 RGB/MS cldy high New GCP’s 
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2018-09-01 UE 2 eBee TH ovc low Drought  

Post Flight Image downloading 
Download all images to a computer and backup the folder as soon as possible after a flight.  Use a 

labeling scheme for new folders including camera type (rgb, ms, or th), followed by a 3-4 letter location 

identifier (irri), and date in yyyymmdd format (eg., rgbirri20180827). Create a new folder inside this 

folder, label it “img” and copy all images to the img folder.  Open the folder and view the contents in 

large icon view so you can quickly review the images to be sure they look fine   

Note the number of images as shown in the lower left hand corner of the explorer window; this should 

be similar to the number estimated by the flight control software.  If many images are missing or have 

problems (sunspots, blurred, over/under exposed) then repeat the flight as soon as possible making sure 

to check that the camera settings are appropriate and the memory card is not full.  If the images are 

fine, then backup the folder to another hard drive or cloud backup.  Once backed up, delete the images 

on the card as needed to ensure there is sufficient space for the next flight and put it back in the 

camera. 
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PIX4D Image Processing 

Create New Project 
Open PIX4D and click on New Project to create the project file.  Name the new project the same as the 

folder name where the images are located (eg. rgbirri20191122) and create it in that folder.  Leave the 

project type button set to “New Project” and click Next.  Click on Add Directories, click on the img folder, 

and click the Choose button below.  A new window will display a list of all the images, click Next, and the 

images will be loaded and the Image Properties window will display.  Here you can review various 

properties of the images and verify the camera model.  When using GCP’s , you typically need to 

manually edit the Altitude values in order to easily find and mark them later.  

Methods for recording altitude on the images can vary depending on the cameras and drones used and 

are not always consistent with elevation data of the GCPs as measured using a GPS (ie., using geoid 

height).  This can lead to problems in marking the GCPs during processing.    Check for such discrepancy 

by comparing the altitude recorded for an image as shown in the image properties editor of PIX4D with 

the elevation of a nearby GCP recorded using a high accuracy GPS + the programed flight altitude above 

ground level.  If there is a large difference (> 5 m) between measurements, the altitude information for 

the images should be changed in PIX4D.  No correction is needed for drones such as the Sensefly eBee 

that use geoid height when tagging images. 

The image altitudes can be changed using the image properties editor which is displayed during the 

initial project creation or can later be accessed under the Project menu.   Change all image altitudes to a 

value equal to the approximate GCP altitude + flight altitude above ground level.  For example, if GCP 

altitude ≈ 40 m, Flight altitude = 35 m, then set all image altitudes to 40+35=75 m.  This is done in the 

image properties editor by right clicking on the first image elevation value then clicking on “Edit All 

Altitudes”  and inputting the calculated value prior to initial processing.  Remember to do this prior to 

initial processing, if you forget, you can do it after initial image processing but must then click on 

Reoptimize under the Process menu before proceeding to mark GCPs.  Once updated, click Next. 

 

The Select output coordinate system window will open showing the auto detected WGS84/UTM zone 

corresponding with the images.  This can be changed here if you prefer a different output such as for 

Taiwan: TWD97/TM2 zone 121 (EGM96 Geoid), by clicking on Known Coordinate System then Advanced 

Coordinate Options, then From List… and selecting the appropriate Datum and Coordinate system.  Then 

click Next.  
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The Processing Options Template will open and show the default processing options for various project 

types.  After selecting a default project template you can modify it and save it as a Personal template for 

use later.  Initially use the Standard options, 3DMaps for RGB or Ag Multispectral for the multispectral 

camera, or Thermal Camera under Advanced.  Then modify them as follows based on the camera type. 

 

RGB 

Step 1 Initial Processing -leave unchanged for most cameras (global shutter/fast response) or set 

Internal Parameter Optimization under the Calibration tab to “All Prior” for cameras with rolling shutter 

(e.g.,  Zenmuse X5). 

Step2 Point Cloud and Mesh 

-Point Density: set to Low(fast) for high resolution imagery(<1cm/pix) or optimum for lower resolution 

-uncheck options under Export on both the Point Cloud and 3D Textured Mesh tabs unless desired 

-uncheck Generate 3D Textre Mesh unless desired 

Step 3 DSM, Ortho and Index 

-check everything on DSM&Ortho tab except Google tiles and select Type: Sharp and Method: 

Triangulation 

- leave everything unchecked on the other tabs 

Next click on Save Template, give it a name for use later and click Ok then Ok again on the Processing 

Options window to exit.  The main processing window will appear showing the location of the images as 

red dots.  You can go back by clicking on the Processing Options button if you need to review or change 

anything.  In the future you can simply select your Personal template with the options setup the way you 

want them.  

Multispec  

Step 1 -leave unchanged.  

Step2 – change Point Density to Optimal on the Point Cloud tab if DSM desired else leave as Low 

Step 3 – click on GeoTiff and Merge Tiles under Raster DSM on the DSM and Ortho tab if desired 

Switch to the Index Calculator tab and click on Calibrate for each color band to verify the calibration 

panel image is present and is properly selected and the Reflectance factor is correct.  Click ok and the 
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adjacent check box should be green.  Scroll down and click on Merge Tiles under Reflectance Map and 

save the new template as before. 

Thermal 

Steps 1 & 2 –leave unchanged. 

Step 3 - click on Merge Tiles under Reflectance Map on the Index Calculator tab and temperature [C] 

under Indices and save the new template as before. 

Processing 

GCP manager 

Processing is conducted in 3 steps but steps 2-3 are typically combined.   When using GCPs, add them to 

the project using the GCP Manager found under the Project menu.   You can import them using a “.csv” 

file of points using the selected coordinate system.  Alternatively, enter them manually using the Add 

Point button the first time and then save them using the Export GCPs button for importing in 

subsequent projects Click Add Point, then double click where it says Manual Tie Point to see a drop 

menu and select 3D GCP.  Next enter the X,Y, and Z coordinates by double clicking on the values.  Repeat 

for each of the GCP’s then click on the Export GCPs button and use browse to save them in a folder for 

future use.  Label the GCP file with the same location code you used for the project file and include the 

date they were measured and place in a folder called GCP for ease of use later.   

    

As described at the bottom of the GCP manager window, the GCP’s need to be marked either after first 

running processing step 1 and using the rayCloud Editor (recommended for desktop processing) , or they 

can be marked right away using the Basic Editor (recommended for cloud processing RGB images).  Click 

OK to exit after exporting the GCP’s.  The image area will now have blue + marks showing the location of 

the GCP’s.  Check to verify they are in the right locations, if not, reopen the GCP manger to correct the 

problem. 

Desktop processing 

Make sure only step 1 is selected and click on Start to run the Initial Processing.  This can take 30 

minutes or much longer depending on the size of the project and speed of your computer.   Once 

completed, the quality report will open so you can review the initial results.   Ideally, the first 4 quality 

checks will be green circles with check marks indicating that the processing was successful.  Only the 
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Georeferencing check should have a yellow triangle with ! indicating the GCP’s still need to be marked.   

If you see any problems, they may need to be addressed and step 1 repeated.  Click on the blue circle 

above the table to get more information on possible problems and solutions.  For example if Images 

shows a problem, there may be a problem with the camera or settings during flight.  If Dataset indicates 

multiple blocks it may still process fine but indicates some images were from a different location or 

elevation (e.g., taken on the ground).  If Camera optimization exceeds 5% then you need to load 

optimized parameters following the instructions provided on the Support page by clicking on this link:  

optimize .   If matching is low, the overlap may have been too low and requires flying another mission 

with higher overlap. 

 

GCP marking with rayCloud 

After resolving any problems with step 1, its time to mark the GCPs using the rayCloud view.  Expand the 

GCPs tab under Tie Points to see the list of GCPs previously entered into the GCP manager.  Click on the 

first GCP and images will appear on the right side of the screen showing the approximate location of the 

GCP.  Use the Image Size and Zoom Level sliders to locate the GCP in the images , then use your mouse 

and scroll wheel to zoom in and click on the center of the GCP.  Do this on at least 4 RGB images then 

click apply to save your marks.  Repeat for the remaining GCPs.  For multispec, click on 6 images, 3 green 

and 3 nir for each GCP.   When complete, click on the Process menu then Reoptomize and Ok  to initiate 

the georeferencing process.   Once completed,  click on the Process menu then Generate Quality Report 

to see an updated report that now shows the georeferencing results.  If green, then its ok to proceed 

with steps 2-3.  If yellow,  the GCP error exceeds 2x the average ground sampling distance (GSD).  If the 

GSD is very small (<2 cm) and the plots are large, then a 2-5 cm error may be acceptable and its ok to 

proceed.  Alternatively, scroll down the quality report to review the more detailed analysis of GCP error 

to identify which GCPs are problematic.  Then  either try marking more images for the GCPs with higher 

error or deleting them completely and reoptimzing as before.  If red, then the error exceeds 4x the GSD 

and should likely be addressed using the same steps as above.  Also double check that the coordinates 

for each GCP are correct. Remember to Reoptimize after making any changes to the GCP’s and to 

generate a new Quality report to verify the GCP error is acceptable.  Finally, uncheck step 1 and click on 

both step 2 and 3 and click on Start to complete the processing.  This may take 1 or more hours 

depending on the size of the project and speed of your computer.   

https://support.pix4d.com/hc/en-us/articles/202560059-How-to-change-the-Camera-Initial-Values-to-the-Optimized-Values
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Cloud Processing (suggested for large RGB projects) 

Processing of RGB imagery can be very slow on a desktop and conducted much more efficiently using 

cloud processing.  PIX4D Cloud is also useful for backing up projects and sharing them with others.  

Note, PIX4D Cloud will limit the number of images that can be processed and the number of projects 

that can be stored based on your license.   

Cloud processing can automatically mark GCPs if they meet PIX4D requirements.  If so, the project must 

be created using the online Cloud interface.  If not, one can mark them in advance using the Basic Editor 

found in the GCP Manager window.  Following desktop project creation, open the GCP Manager and 

enter the GCP coordinates either manually or by importing them as described previously.  Then click on 

the Basic Editor to mark the GCPs and click on the first GCP to select it.  The Basic Editor will show the 

approximate location of the selected GCP, use your mouse to zoom in and locate the GCP and click in 

the center of 4 or more images then repeat for the remaining GCPs.  After marking all the GCPs, click on 

OK to close the GCP Manager, the location of the GCPs will now show as blue + marks in the map view.   

Next click on the Processing tab and click and check all 3 processing steps for cloud processing.  Lastly 

click on Upload project files… under the Project Menu, check the Start Processing box and click Upload 

to begin uploading the images and project files to the PIX4D cloud.  The cloud server will send an email 

with an estimated time to completion as soon as the files have finished uploading.  A second email will 

be sent when the processing is completed and will include a link for downloading the project files.   

Open the link and select to download the project files, and then wait for another email with a link to 

download a zip file with all the project files.  Unzip the files to the project folder; the project will have 

the same name but with the suffix “_full”.   Open the PIX4D project file inside this folder to view the 

completed project; use the mouse to select the img folder when prompted.  Next, open the Quality 

Report under the Process Menu to verify the success of the processing including the GCPs.  If the report 

is ok then close the project, cut the files from the “…_full” folder and paste them into the main folder 

selecting to replace the previous files with the new one and then delete the empty “…_full” folder. 

 If there are any problems indicated by the Quality report, resolve them as described previously and click 

on Reoptimize under the Process Menu or rerun step 1 to apply the correction.  Then Click on Generate 

Quality Report under the Process menu to verify the problems were resolved.  Next, check only steps 2 

and 3 on the Processing tab and upload the project again to repeat cloud processing with the 

corrections applied.    

Image Processing Outputs 

After completing the 3 steps of image processing, the outputs will be located within a series of 4 folders 

found inside the project folder.  A pdf copy of the quality report is located in the 1_initial folder; the 

point cloud .las file in the 2_densification folder; the digital surface model and orthomosaic (rgb) maps 

in the 3_dsm_ortho folder, and; the reflectance maps in the 4_index folder.  Don’t change the name or 

reorganize these folders since the data extraction procedure requires that the files retain this standard 

organizational structure.   
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Plot level Data Extraction 
Plot level pixel data is extracted and processed using R studio.  This requires installation of R studio 

along with a set of R-packages listed in the primary R data extraction script (https://www.rstudio.com/ ).  

The extraction script calls a number of custom functions that should all be located in the same folder as 

the primary R data extraction script (the “working directory”).  The data extraction requires a digitized 

shapefile of the field layout, which can be created using ArcMap as described in the following section. 

Field Layout Shapefile Creation-ArcMap 
The field layout shapefile is a spatial data file with the plots digitized as 

spatial polygons and includes plot level attributes such as the plot ID, row, 

column, and ground elevation.  The shapefile is created using the fishnet 

tool in ArcMap.  Begin by adding an image layer (RGB-orthomosaic or 

Multispec –reflectance) from an early season flight to ArcMap.  Set the 

ArcMap coordinate system to be the same as the image file (e.g., 

WGS_1984_UTM_Zone_51N).  Rotate the image layer so that the plot rows 

are aligned in east-west direction (View-> Data frame properties->rotate).  

Click on the “identify” tool and use the mouse to zoom in on the plot in the 

lower right corner of the field and click on the first hill in the lower right 

corner of the plot.  Write down the coordinates of the hill, this is the 

Fishnet Origin.  Next zoom to the plot in the lower left corner of the field 

and click on a hill in the bottom row.  Write down the coordinates of the 

hill, this is the Y-axis Coordinate.  Now open the Create Fishnet tool 

(ArcToolbox ->Data Management Tools-> Sampling) and click on the Output 

Feature Class –folder icon to browse to a folder for storing the output, and 

enter an output file name.  Next input the Fishnet Origin and Y-axis 

coordinates.  Enter the width of the plot in meters (Cell size Width), based 

on the row spacing and number of rows per plot.  Next enter the length of 

the plot less about 0.2 m (Cell Size Height) to compensate for variation.  Then enter the number of plot 

rows as counted from right to left and the number plot columns as counted from bottom to top.  

Uncheck the Create Label Points option, select “Polygon” as the Geometry Type, and click OK.  This will 

create a polygon shapefile aligned with the layout but requiring additional editing to adjust for spacing 

between plot rows and columns and irregularities in the layout.   

Change the plot symbol to have no fill and bright colored outline for ease of editing.  Right click on the 

plot layer and select “Edit features” to begin editing.  Use the Edit tool to select and move the plot rows 

and columns to align them with the plots in the image.  Continue using the Edit tool to align the plots as 

needed.  Save the changes and stop editing using the Editor tab.  Right click on the plot layer and open 

the attribute table. Click on the Table Options tab and add fields for “row” and “col” as type Short 

integer.  Delete the “Id” field then add a field for “ID” as type Short integer.  Add a field for “Elevation” 

as type Float.  Add more fields for plot level attributes of interest (ie, entry, rep, and block).  Be 

consistent with the use of capital letters in the attribute names since R is case sensitive.  ArcMap will 

assign an FID number beginning with 0 to each polygon in order of increasing column then row, as in a 

https://www.rstudio.com/
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matrix with the origin at the plot in the lower right corner and the last plot in the upper left corner.  The 

next steps involve filling the attribute columns with values that match with the experimental layout.  

This can be facilitated using an excel spreadsheet to quickly generate row, col and ID numbers in an 

order that matches the layout scheme with the order of the FID.  After completing the spreadsheet, 

right click on the plot layer and select “Edit features” to begin editing and open the attribute table.  

Copy the row values from the spreadsheet, right click on the first cell of the row column in the attribute 

table and select paste to populate the values.  Repeat with the col and ID values.   

The ID values must be in the same order as the FID values in order for the extraction to work correctly.  

This is accomplished using the sort tool (Data Management Tools-> General->Sort).  Use the drop menu 

to select the plot layer, click the output folder icon to locate the folder of the original file and enter the 

same name with the suffix “_sort”, select ID as the sort Field using the drop menu, and click OK to sort.  

The next step is to use the “buffer tool” (Analysis Tools->Proximity->Buffer) to make the plot polygons 

smaller thereby eliminating border rows from the data extraction.  Start by changing the default End 

Type to “FLAT” using the drop menu.  Next, use the drop menu to select the sorted plot layer as Input, 

click the folder icon to enter a new name for the output replacing the “_sort” suffix with “_buf”, enter a 

negative value in meters to reduce the sides of the polygon (e.g., buffer 20 cm:  -0.2) and click OK.  This 

will create a new shapefile with smaller polygons centered over each plot that retains the attributes and 

sort order.    

Field Layout Shapefile Creation-QGIS 
Open QGIS and open Project->properties and set General settings as desired. 

Click on selection color and set opacity to 30% 

Set the CRS to your location in UTM 

Click View->Toolbars-> and check Advanced digitizing toolbar 

Add image layers: Layer->Data Source Manager 

 

RGB Composit (optional) 

Make RGB composit form multispec: Raster->Misc->Merge 

Select RGB input layers: Input layers ->...->check rgb layers->click OK 

click: Place each input file into a seperate band 

click selection box below and select "save to file" then click Run 

rightclick on new RGB layer and select properties 

Select Symbology and update band numbers: red -band 3, green- band 2, blue-band 1 

Set all Min values to the lowest Min val, Set all Max values to the highest Max value, click OK 

Can set min/max cumulative count to 0.2 and 99.8 for darker image... 

 

Make grid: 

click Processing->toolbox 

search in toolbox for "create grid", click on tool 

set Grid type to Rectangle 
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click extent drop box and select to draw on map then click and drag on map to cover large enough area 

for layout 

set horiz and vert spacing as needed for your plots and click run 

click on Grid layer (right side icon) to save file, add name and path, select as .shp file, click save 

right click on Grid layer and select rename to change the name 

double clilck new grid layer to open properties -> symbology-> select outline red and set opacity to 25% 

 

 

Adjust grid: 

Click select tool-. click and drag to select whole grid 

Click edit tool (pencil) ->click rotate tool, click on grid and move mouse to rotate, click again to stop, 

repeat as needed 

click move tool, click on grid and move to align with field, click again to stop, repeat as needed 

click rotation box arrows (bottom right) to rotate map to be square with your screen, click on the 

rotation value to fine tune 

click on select tool-> select extra plots and click delete to remove 

select row plots and move using the move tool to fine tune locations 

 

Populate attribute table: 

right click grid layer -> open attribute table 

click edit tool -> New Field icon -> add "Id" , "row", "col", "plot" , all as integer 

click New Field -> add "Elevation" as real 

 

Populate the fields using the attribute table field calculator 

click select tool-> select plots for updating attributes (ie., first row of plots) 

select the field in the field calculator and then enter the value for the selected plots (ie., row = 1) -> click 

update Selected 

repeat for other fields, click on expression builder button to see expressions (ie., col = @row_number) -> 

click update Selected 

repeat using more complex expressions and/or different sort orders as needed 

 

Plot Elevation 

Data for the plot Elevation values can be acquired in several ways.  One approach is to use a digital 

surface model (DSM) generated from a flight conducted over the unplanted field.  Add this DSM layer to 

ArcMap then use “Zonal Statistics as Table” tool to create a table of mean elevation values for each plot 

(Spatial Analyst Tools->Zonal->Zonal Statistics as Table).  Use the drop down menu to select the plot 

layer as the feature zone data and select the ID column as the Zone Field.  Select the DSM as the Input 

Value raster, use the folder icon to select a location and input a name for the output file including the 

file type suffix “.dbf” so that is saved in a database file format that can be opened in excel and click OK.  

Once completed, open the file in excel to view and analyze the table of elevation values.  The table of 

mean values will show some degree of variability both within and between plots which can be used to 
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help improve the overall plot elevation estimates.  Also look at DSM color figure (fig. 1) in the PIX4D 

processing report to visualize the overall slope of the field.  Using this information, consider assigning 

the plot Elevation values based on the mean elevation of a given row or col of plots. If a preseason 

image is not available, then open a later flight in PIX4D and use a mouse in the rayCloud view to select 

ground level pixels around the field to estimate the range of elevation values along the elevation 

gradient.  A third option is to manually conduct an RTK GPS survey of the field.  Lastly, subtract 0.20 m 

from all the Elevation values regardless of how they were estimated and assign this value to plot level 

Elevation column.  Note that global mathematical operations can be conducted on any column in the 

attribute table by right clicking on it and selecting the Field Calculator.   

R-Based Processing 
Open the “DroneExtract…” script in R-Studio and update the input and output options based on the 

current trial as follows.  Update the working directory, and date of the flight.  Update the site code and 

the file path for the imagery.  Update the plotpath and plotfile name.  Update the angle to align the 

rows in an east-west direction, view the output report to verify.  Update the output path, outlist and 

CCout, as needed for naming the output file. Update the report name as desired.  The script is now 

ready to run.   

When first setting up the script, it’s a good idea to run it in a step wise fashion to verify that there are no 

errors.  Click and drag the mouse to select the first section of the script, from the beginning to the 

command “images”, click on Run.  This will load all the packages and functions and begin processing of 

the input and output information, and reading in of the plotfile.   The progress can be viewed in the 

Console which will also show summary information about the plotfile and a list of file paths and 

associated files for the imagery.  Review the Console output to check for any errors and to verify the 

plotfile and list of imagery files were successfully loaded.  If there are any errors, review the inputs to 

correct the problem and repeat running of the first section of the script through to the command 

“Images”.   

If there are no errors then proceed to run the next section from “images” to “head(j,10)”.  Monitor the 

Console to see the status and to review an output table of values for the first 10 plots.  Next, open the 

pdf output report in the output folder to verify that the rgb and multispec map where plotted and the 

angle assigned in the input section was correct.   

Next run the rest of the script to generate a CSV file of values for each plot on the given date.  Open this 

file to review.  If everything looks OK, save any changes made to the script so that the inputs are 

retained.  Now you can process additional flights by simply updating the date and threshold settings (as 

needed) and running the entire script at once or stepwise as desired.   

Data Analysis 
The plot level data tables include the flight date, all attributes from the field layout shapefile, and 

median values of the plots for all camera bands, vegetation indices, and canopy height.  Upper 

percentiles (97th) for canopy height and some indices.   Standard deviations and pixel counts for each 
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camera band are also included and can be used for filtering of plots with high variability (i.e., resulting 

from poor establishment or pest/disease).  Percent cover is estimated using 2 different methods, one 

that is index based using the RGB (PCRGB) and one using the multispec (PCMS) and one based on the 

average of the PCRGB and PCMS (PC).  The data for each flight can be combined into a master file for 

analysis.  This can be done in done in either a wide (each file appended by column) or long (each file 

appended by row) format.   

Master File Wide format 
First create a file with only the plot shapefile attributes and any additional plot level parameters such as 

replication, block, and entry that you want included in the master file and save it in CSV format in a new 

folder location.  Open the “Combinewide…” script in R studio and update the inputs.  Set the working 

directory to the output path used in the Extraction script. Set the Masterfile to the full path and file 

name for the Masterfile created above.  Update the dates to the dates of the flights. Enter a full path 

and file name for the output file in CSV format.  Update the column number assignment  

(fisrstdatacol=#) referencing the first column of data in the extracted data files (ie., column number for 

HT or reHT ).  Run the script to create the wide format file, the data columns will have the date (mmdd) 

added as a prefix.  This format is useful for analysis of genotypic means, conducting a global correlation 

analysis with manually collected data and for comparing variables across dates.   

Master File Long Format 
First create a file of column headings (no data) that matches the extracted files and save it in CSV format 

in a new folder location. Open the “Combinelong…” script in R studio and update the inputs. .  Set the 

working directory to the output path used in the Extraction script. Update the file name and path for the 

output.  Update the full path and filename of the heading file created above.  Run the script to create 

the long format Masterfile, it will have a new first column for flight number followed by the same 

columns found in the original extracted data files.  This format is useful for time series analysis and for 

quickly accessing the data by flight number or date. 
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Appendix A: DJI GS Pro Step by Step 
The mission is the general flight plan and includes all the information needed for flying the drone 

autonomously over the area of interest.  Once saved, it can be used again to fly the same mission.  As 

noted previously, a WIFI connection is needed for initial mission planning in order to download the 

basemap satellite imagery, but WIFI is not needed during flight.  There is no need to connect to the 

drone during the initial mission setup.  However, the camera parameters can only be adjusted while 

connected to the drone and should always be checked prior to flight to be sure they are correctly set for 

the mission.  

DJI GS Pro: Mission Planning 
Step 1: tap on New -> 3DMap Area->Tap   

Step 2: drag the map with one finger and zoom in/out using 2 finger pinch to find the field area. 

Step 3: tap near the center of the field and a box will appear. 

Step 4: drag each corner of the box to the corners of the field. 

Step 5: rename the mission by tapping on the pen icon right of the Mission 1 label, then tap return 

Step 6 : set Basic parameters: 

tap on the > icon next to each parameter and set: 

 Camera Model: select from drop down list based on drone model 

 Shooting Angle: Course Aligned 

 

 

 

 

Main mission planning screen 

 

Save mission 

Mission name 

Mission information 

Basic/Advanced parameters tab 

 

Mission parameters 

 

Help -> User Manual 

Enter Flight mode 

Camera preview -> camera view/settings 
Flight telemetry information  

To home page  

Start waypoint 
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 Capture Mode: equal distance interval (optional: Equal time Interval) 

 Flight Course Mode: Scan Mode 

Shutter Intv: 2.0 sec (jpg), 5.0 sec (raw),  (tap on number and tap on +/- to set then tap on 

screen to return) 

 

The remaining settings are based on the drone model/camera as indicated in Table 1. The values shown 

here are an example for the Phantom 4 pro. 

 

Altitude: 35.0 m (drag slider to get approximate value, tap on number and tap on +/- to set then 

tap on screen to return) 

Step 7: set Advanced parameters ( tap on the Advanced tab above the Camera Model) 

 Front Overlap: 85 (use slider and/or tap on the number to adjust) 

 Side Overlap: 80 

 Course Angle: adjust so flight lines are parallel to the length or width of field-as described earlier 

 Margin: 5 m (this makes the coverage area larger, increase as needed to get extra flight lines on 

each side of the field as described earlier. 

 Gimbal Pitch Angle: -90.0 

 End-Mission Action: RTH Alt 35.0 m (return to home altitude, set to same as mission or higher to 

avoid obstacles (trees, buildings) between mission end and landing area) 

Step 8: tap on save mission icon to save (upper left corner ) 

Step 9: view mission information (waypoints, area, flight time, batteries, pics) by dragging the boxes 

below the mission name left or right 

Step 10: tap the to Home button < to return to the home page and see the list of saved missions 

DJI GS Pro: Fly mission 
Step 1: connect to the drone using the remote controller and open DJI GS Pro  

Step 2: tap on the saved mission to select it and tap on edit to open it  

Step 3: tap on the camera preview icon, then again on the preview screen to enter full camera view 

Step 4: tap on the Camera settings icon to adjust parameters if needed 

 

 
Camera settings - Auto mode                  Image size, format, and white balance options 

 

Camera 

settings 
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Step 5: check the image, picking up the drone to get a better view, making sure the image looks ok 

Step 6: tap save mission icon if you made any changes 

Step 7: switch the remote control flight mode toggle to the correct position for automated flight (P for 

Phantom 4, F for Matrice 100) 

Step 8: Tap the flight mode icon upper right corner 

Step 8: Check and adjust the drone according to the checklist until all items are green 

Step 9: tap start to fly and the drone will fly to the start point automatically and fly the mission 

 

 

 

 
Full camera view 

During flight, you can tap the Pause Mission button on top right corner to pause the mission (e.g. to 

allow cloud to pass).  Additional options then appear for 1) resume from last point, 2) start over, 3) 

cancel mission, and 4) back to mission list. 

If the battery level drops below the pre-set warning value (30%), an audio prompt will sound.   At this 

point it’s generally  safe to let the drone complete its current transect but you should land the drone 

soon to change batteries.  Never let the drone battery go below 20%.   Tap the pause button, switch the 

flight control toggle on the remote to the position for manual flight (F for Phantom 4, P for Matrice 100) 

and take over manual control to land the drone.  Alternatively, tap the pause button then the Return 

Home button for automated landing.  After landing, power off the battery, change it out, power it back 

on, switch the toggle back for automated flight if needed and tap on “resume from last point”.   Then 

tap start to fly after the check list is complete, and it will resume from where it left off.  

Camera settings 

Map view 

Current camera parameters 

Return home 


